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--IINNTTRROODDUUCCTTIIOONN--  
 
The Four-dimensional Stormcell Investigator (FSI) is an innovative base radar data 
display application that is based on the National Severe Storms Laboratory (NSSL) 
Warning Decision Support System – Integrated Information (WDSSII) graphical user 
interface (wg).  This technology allows users to create and manipulate dynamic cross-
sections (both vertical and at constant altitude), such that one can “slice and dice” storms 
and view these cross-section data in three-dimensions and across time.  The FSI is a 4-
panel display depicting base radar data from a variety of linked two- and three-
dimensional representations.  An AWIPS D-2D extension is used to launch this 
application into an independent window. 
 

 
 
We will make this user guide as comprehensive as possible – sort of an “FSI for 
Dummies” document.  Accompanying this lengthy user guide will be a short FSI Quick 
Reference Guide which can be used to access the most commonly used functionality of 
the FSI. 
 
Also bear in mind that this user guide only describes the knobology of the FSI.  
Information about how to scientifically analyze severe storms in three-dimensions for 
warning decision making is part of the training materials prepared by the NWS Warning 
Decision Training Branch. 
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Once Upon A Time… 

In the pre-WSR-88D era, many radar consoles allowed operational meteorologists to 
manually control the radar beam, including some rudimentary capabilities to view 
vertical cross-sections (e.g., the Range-Height Indicator, or RHI).  These radar display 
and control capabilities allowed research and operational meteorologists to amass 
expertise in the horizontal and vertical structure and evolution of severe storms, and 
allowed for the development of the first operational guidelines for diagnosing base radar 
data in identifying supercell storms (a.k.a. the “Lemon Technique”).  The WSR-88D 
operates using automated volume coverage patterns, and display techniques to convert 
elevation scan data into vertical cross-sections is not very user friendly. 

The Future of Radar Analysis is here… 
 
The many benefits of the FSI are as follows: 

• Improved vertical cross-sections: Dynamic placement and re-position of a cross-
section reference line showing real-time updates to the cross-section data. Cross-
sections are no longer a one-time requested RPG product, and are instead 
generated on-the-fly using 8-bit data. 

• Constant Altitude cross-sections (CAPPIs): 8-bit radar data plotted at constant 
altitude eliminates the need to sample elevation scan data for altitude or reset 
elevation angle choices in four-panel displays. Cross-section control is also 
dynamic, showing real-time updates to the cross-section data. 

• 3D visualization: 8-bit radar data from elevation scans, vertical cross-sections, 
and CAPPIs are plotted as 2D textures in 3D space. A forecaster can zoom, pan, 
pitch, yaw, and fly about the data in 3D. 

• Virtual Volumes: No volume scan is incomplete. As new elevation scans are 
updated, they replace the old elevation scans in the virtual volume one-by-one. 
This means that there are full volumes of data available at all times for cross-
sections and data perusal. 

• Access to a much larger data inventory: An “All-Tilts” product only allows the 
forecaster to peruse a sequential order of elevation scan frames. For a 64 frame 
limit in VCP12, that only comprises 5 volume scans. The FSI allows the user to 
access any elevation scan in the radar data inventory RPS list for up to 2 hours of 
8-bit data for all elevation scans. 
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--TTHHEE  FFSSII  EEXXTTEENNSSIIOONN  IINN  DD--22DD--  
 

Loading the Extension 
 
The FSI extension is loaded and automatically made editable by selecting the 4-D Storm 
Investigator (FSI) selection within either 1) the Applications section of the drop down 
Radar menu, or 2) the Tools menu. 
 

        
 
Once the extension is loaded, the legend will list that extension with the instructions on 
how to launch the FSI (“FSI, when editable, Right-click over storm (Editable)” 
 

 
 
You unload the FSI extension in the normal way you unload any depictable on the D-2D 
pane – by holding the right mouse button over the legend until the pop-up table appears, 
then select “Unload”. 
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Launching the FSI 
 
Center your cursor over the storm of interest on your D-2D pane, and click the Right 
mouse button.    If your WFO only has one dedicated radar, the FSI window will 
automatically open, with the data already centered on your storm of interest, using the 
radar data matching either your WFO’s dedicated radar. 
 
If your WFO uses more than one dedicated radar, or your backup radars are turned on for 
SCAN, a radar selection GUI will open.  Choose the radar you wish to observe, and click 
the “ok” button. 
 

 
 
The following FSI display initial conditions will be reset to these values each time you 
launch or re-launch the FSI from the D-2D: 
 
 Product = Reflectivity at 0.5° at the latest time 
 Location = centered in latitude/longitude of mouse click on the D-2D 
 Zoom Altitude = 50 meters (about the size of a large supercell storm) 
 CAPPI Altitude = 2 km (~6.5 kft) 
 Vertical Cross-Section Altitude = 20 km (~65 kft) 
 3D Rotate = 360° (pointing north) 
 3D tilt = 0.75 (slightly tilted off the vertical) 
 Storm Motion Vector = as set by Radar Product Controls 
 
All other display preferences (e.g., loop parameters) will be retained from the previous 
FSI session.  These preferences are unique to each individual username. 
 
NOTE:  The new LX workstations are equipped with two video graphics cards, one 
which supports 2D applications, and the other which supports 3D applications such as the 
FSI.  The FSI cannot be launched on the 2D display, and a pop-up window will appear to 
remind users if this is attempted 
 
NOTE:  Only one FSI display is designed to running at any one time per workstation.  If 
you attempt to launch another FSI display using another mouse click to the D-2D pane, 
the original FSI window will reposition to a new storm location. 
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--TTHHEE  FFSSII  WWIINNDDOOWW--  
 

A Summary of the FSI Components 
• Linked four-panel design, with a constant elevation angle panel, a CAPPI panel, a 

Vertical Cross-section panel, and a panel displaying the data in three-dimensions. 
• D2D All-Tilts “look and feel” radar volume browsing controls. 
• Animation (looping) controls for the added 4th dimension. 
• Keyboard shortcuts (“hotkeys”) for selection of elevation angles, volume scan 

times, radar products, and other navigation short-cuts (e.g., reset to zenith view). 
• Rapid panning, zooming, pitch and yaw of 3D data. 
• Dynamic cross section capabilities (vertical and horizontal). Users can manipulate 

the location of a cross section reference line using mouse controls, and cross-
section textures will dynamically update on-the-fly in the other panels. 

What do you see when the FSI is launched? 
 
Menu Bar 
At the very top of the FSI window, you will see a series of drop-down menu selections 
(File, Navigate, Camera, Options, Products, Map, Help).  A Left Mouse click on any 
of these words will drop down its corresponding menu.  A second Left Mouse click on 
any of the selections will execute the action specified. 
 

 
 
Note that for most of the selections in the drop-down menus, the list will include two 
columns.  The left-hand column is a description of the action taken.  The right-hand 
column is a corresponding Hotkey.  For any command that has a corresponding Hotkey, 
that command can alternatively be executed by pressing that key or combinations of keys 
(if combined with Shift, Ctrl, or Alt) on the keyboard.  You will find that for many of the 
menu selections, the Hotkey controls will be the preferred method for selection, as they 
require fewer mouse clicks to execute which allows for more rapid selection and rapid 
successive selections. 
 
We will describe only a few of these menu options in this section.  The other menu 
options are described in later sections, and can be accessed by clicking the menu word 
above (these are links to future sections in this user guide). 
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 File 
 

Save Settings:  This action will save your current settings to a 
configuration file that is stored on your user account, without exiting the 
FSI.  Note: only one configuration file is available per user. 
 
Reset Settings to Default and Exit:  This action will restore the FSI 
default settings, and overwrite these default settings to your personal 
configuration file.  It will then exit the FSI, since the configuration file can 
only be loaded upon launching the FSI.  Users will need to relaunch the 
FSI for the default settings to take effect. 
 
Exit:  This action will save your current settings to a configuration file 
that is stored on your user account, and exit the FSI. 

 
 Help 
 

About FSI:  This shows a pop-up window containing information about 
the FSI.  This pop-up window is closed using its Close button. 
 
NOTE:  A link to a PDF version of this user guide may be added here in 
the future. 

 
Button Panel 
The second row in the FSI window begins on the left with a series of button selections 
(Preferences, Snapshot, Color Key, Loop, Auto-Update, Isosurfaces, Plan View, 
Reset).  After that there are three navigation buttons (Back, Next, Latest). 
 

 
 
A Left Mouse click on any of these will execute the button action.  Some of these buttons 
are toggle buttons.  If the action is toggled, the background color of the button will turn to 
a darker gray. 
 

 Preferences    
 

This button will open up the Edit Preferences pop-up window.  More 
information about setting preferences is provided in the Setting Preferences 
section.  
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Snapshot    
This button will open up the Take Snapshot pop-up window.  More information 
about taking and saving screen image captures is provided in the Taking 
Snapshots section. 

 

Color Key    
This button toggles the color key off/on at the top of the 3D Flier window.  Its 
default position is on. 

 

Loop    
This button toggles looping (animation) off/on.  Looping Preferences can be 
changed using the Edit Preferences > Loop tab.  Its default position is on. 

 

Auto-Update    
This button toggles the automatic updating of radar data off/on.  Any time the 
currently browsed elevation angle is updated, the display will update to show the 
new data (without changing elevation angle).  Its default position is on upon 
startup of the FSI.  Any time the user navigates back in time away from the latest 
virtual volume scan, the Auto-Update button automatically turns off.  Any time 
the user navigates forward in time back to the latest virtual volume scan, the 
Auto-Update button automatically turns back on.  The “A” Hotkey also toggles 
the Auto-Update. 

 

Isosurfaces    
This button toggles 3D isosurfaces off/on.  Its default position is off, and is 
currently disabled pending future development of the application. 
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Plan View    
This button resets the viewing angle of the 3D Flier window to be from 90° 
elevation (zenith view, top down), and positions North to point straight up.  Its 
default position is on.  Anytime the user changes the viewing angle in the 3D Flier 
window, the button will automatically turn off.  The “P” Hotkey also toggles the 
Plan View. 

 

Reset    
This button restores the FSI display to the initial conditions from when you last 
launched the FSI from the D2D, including the lat/lon position of the last mouse 
click on D2D.  This is a handy feature in the event you accidentally move away 
from your storm of interest and “lose your bearings.” 

 

Back    
This button steps the display back one volume scan interval while maintaining 
constant elevation scan.  If you move the mouse over the button without pressing 
it, a pop-up window will display a preview of the date and time of the elevation 
scan that you would navigate to if you press the button. 
 

Next    
This button steps the display forward one volume scan interval while maintaining 
constant elevation scan.  If you move the mouse over the button without pressing 
it, a pop-up window will display a preview of the date and time of the elevation 
scan that you would navigate to if you press the button. 
 

Latest    
This button steps the display forward one or more volume scan intervals to the 
latest volume scan while maintaining constant elevation scan.  If you move the 
mouse over the button without pressing it, a pop-up window will display a 
preview of the date and time of the elevation scan that you would navigate to if 
you press the button. 
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Radar Status Bar 
To the right of these buttons is Radar Status Bar.  This is a continuously-updating 
readout showing the date, time, VCP, and elevation angle of the most recently-completed 
elevation scan from the radar and product being viewed. 
 

 
 
NOTE:  if you resize the FSI window smaller than the default dimensions, the Radar 
Status Window may disappear.  Stretch the FSI window horizontally just enough in order 
for it to reappear. 
 
 
Plan Position Indicator (PPI) Panel 
Underneath the menu and button rows are the four main FSI panels.  The upper left panel 
displays the base radar data at a constant elevation scan.  In old radar parlance, the “Plan 
Position Indicator”, or PPI, was the electronic scope that displayed the live radar data on 
a plan view, as viewed from top-down.  This method of viewing radar data became the de 
facto standard in the WSR-88D and AWIPS world.  In other words, the PPI panel 
displays the radar data in the way that is most familiar with meteorologists.  The viewing 
angle within this angle is fixed at 90° (top-down) with north facing up.  The radar data 
and map overlays are projected “flat earth”, which is a plane at zero-altitude (above radar 
level) to avoid parallax.  Continuous pan and zoom controls are available.  Within this 
window is the vertical cross-section control tool, which is used to control the vertical 
cross section texture location.  More information on how to use the PPI panel and the 
cross-section control tool is given later. 
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Vertical Dynamic Cross Section (VDX) Panel 
The lower left panel displays the base radar data sampled from each elevation scan along 
a vertical plane that is represented by the vertical cross-section control tool in the PPI 
window.  The cross-section tool allows the user to change the location of the cross-
section, and the data in this display will dynamically update on the fly.  This panel 
displays radar data vertically from the side, and the view is locked perpendicular to the 
plane of the cross-section.  More information on how to use the VDX panel is given later. 
 

 
 
Constant Altitude Plan Position Indicator (CAPPI) Panel 
The upper right panel displays the base radar data at a constant altitude above the radar 
elevation.  Just prior to the advent of the WSR-88D network, a digital radar processor 
was added to several of the old radars which sampled the base radar data from within a 
constant altitude horizontal cross-section from whichever elevation scans intersected it.  
Now this capability is back in the hands of the radar meteorologist, but with one added 
feature – the CAPPIs are dynamic, allowing the user to change the sampling altitude on 
the fly.  The viewing angle within this angle is fixed at 90° (top-down) with north facing 
up.  Continuous pan and zoom controls are available.  More information on how to use 
the CAPPI panel is given later. 
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Three-Dimensional Flier (3DF) Panel 
The radar data in this panel will be plotted in true 3D earth coordinates.  Shown will be 
the selected elevation angle of data in the PPI panel plotted on a conical surface, as well 
as any vertical or horizontal cross-section planes that are being displayed in the VDX and 
CAPPI panels respectively.  All the surfaces will be represented in 3D space.  These three 
data surfaces can be independently toggled off or on.  The user will have continuous 
zoom and pan controls, as well as continuous 3D rotation controls.  The view can be 
quickly reset to a zenith viewing angle at any time.  Within this window is the vertical 
cross-section control tool, which is used to control the vertical cross section texture 
location.  More information on how to use the 3DF panel is given later. 
 

 
 
 

PPI Panel Usage 
 
The Data Area 
The main portion of this panel contains the radar data viewing area.  The radar data are 
plotted using polar coordinates (azimuth versus range), at the highest available resolution 
data as defined by the AWIPS RPS list (8-bit, or even Super-Resolution data when 
available). 
 
Zoom 
Hold down the Middle mouse button to initiate a continuous zoom function.  Push the 
mouse away from you to zoom in for a closer view.  Pull the mouse toward you to zoom 
out for a wider view.  Release the mouse button when completed.  Note that any zoom 
action is simultaneously repeated in the CAPPI and 3DF panels. 
 
Pan 
Hold down the Left mouse button to initiate a continuous pan function.  Drag the mouse 
to “pull” the image to the desired location.  Release the mouse button when completed.  
Note that any pan action is simultaneously repeated in the CAPPI and 3DF panels. 
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Vertical Cross-Section Control Tool 
Move the mouse to one of the Blue Boxes on the red and white dashed arrow and hold 
down the Left mouse button to begin interacting with the tool.  Drag the mouse to “pull” 
the blue box to the desired location.  Release the mouse button when completed.   
 
Interacting with the following blue boxes will provide these actions: 
 

End Boxes 
This will move the cross section line keeping the opposite end box position 
constant. 
 
Middle Box 
This will move the entire cross section line, keeping the line parallel to its 
previous positions. 
 
Second and Fourth Boxes 
This will rotate the cross section line keeping the middle box position constant. 

 

 
 
Note that the arrow will always point to the east, and represents the data on the right side 
of the VDX panel. 
 

VDX Panel Usage 
 
The Data Area 
The main portion of this panel contains the radar data viewing area.  These data are 
derived by computing the “intersection” of an imaginary vertical plane of data with a 
complete “virtual volume” of base radar data.  The data are derived from the polar-
coordinates, and thus are the highest resolution available.  Note that this vertical plane of 
data actually wraps the curved 3D surface of the earth, like a ribbon, in order to maintain 
constant altitudes along the section.  This can be illustrated by viewing very long cross-
sections in the 3DF panel. 
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When the cross-section coordinates are in the process of dynamically changing through 
the various actions available, the data will temporarily “down-sample” to a rectilinear 
grid.  The resolution of this grid is set to 80 x 80 pixels by default (this can be changed 
using the Preferences button).  Once the re-positioning of the cross-section is completed, 
the data will re-draw at the highest resolution available, in polar coordinates. 
 
Reading the Legends 
The upper right portion of this panel contains a height legend, showing the current height 
and the maximum allowable height in kft.   
 
The Y-axis also contains tick marks and labels for the height in kft. 
 
The X-axis contains tick marks and labels for the horizontal distance in nm.  Note that the 
5 tick marks correspond to the 5 blue boxes on the Vertical Cross-Section Control Tool. 
 
The lower right portion of the panel shows the latitude/longitude coordinates of the End 
Boxes of the cross-section, in decimal degrees. 
 
Interpolation Toggle 
The “I” Hotkey will toggle interpolation on and off on the vertical cross-sections and the 
CAPPIs simultaneously.  The default state of the FSI is for interpolation to be toggled on.  
The interpolation scheme will “fill in” the data between the elevation scans in order to 
present a “more complete” cross-section.  However, turning the interpolation scheme off 
gives the user a better idea of which locations in space the radar is actually scanning.  
There are significant gaps in coverage since the radar beam is 1.0° wide (in the horizontal 
and vertical), and elevation angle differences can frequently be greater than 1.0°, 
especially at higher elevations.  The figure below shows the effect of interpolation off 
(left) and on (right). 
 

   
 
The interpolation scheme in the vertical between adjacent beam centerlines, and is not an 
image smoothing technique.  This is important for the CAPPI cross-sections (described 
later).   
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Change Vertical Height 
Move the cursor to the vertical blue bar on the right hand side of this panel.  Then, hold 
down the Left mouse button and drag the top of the blue bar up or down to change the 
height of the vertical cross-section window.  Release the mouse button when completed.  
The cross-section vertical height will simultaneously change in both the VDX and the 
3DF panels (NOTE:  The viewing angle in the 3DF panel must be anything other then 
90° (top-down) in order to view these changes in that window).  As you change the 
vertical height, note the changes in the upper right legend and the Y-axis values. 
 
Change Horizontal Width 
CAUTION:  This action is very sensitive to small mouse movements, and is typically not 
the desired way to change the length of the cross-section.  Instead, we suggest using the 
Vertical Cross-Section Control Tool. 
 
Move the cursor to any position within the VDX “data area”.  Then, hold down the 
Middle mouse button to initiate the horizontal width change function.  Push the mouse 
away from you to narrow the horizontal width.  Pull the mouse toward you to widen the 
horizontal width.  Release the mouse button when completed.  The cross-section 
horizontal width will simultaneously change in both the PPI, VDX, and 3DF panels.  As 
you change the horizontal width, note the changes in the X-axis values. 
 
Change Position 
CAUTION:  This action is very sensitive to small mouse movements, and is typically not 
the desired way to change the position of the cross-section.  Instead, we suggest using the 
Vertical Cross-Section Control Tool. 
 
Move the cursor to any position within the VDX “data area”.  Then, hold down the Left 
mouse button to initiate the position change function.  Drag the mouse to “pull” the cross-
section to the desired location.  Release the mouse button when completed.  The cross-
section position will simultaneously change in the PPI, VDX, and 3DF panels. 
 

CAPPI Panel Usage 
 
The Data Area 
The main portion of this panel contains the radar data viewing area.  These data are 
derived by computing the “intersection” of an imaginary constant altitude surface with a 
complete “virtual volume” of base radar data.  The data are derived from the polar-
coordinates, and thus are the highest resolution available.  Note that this surface of data 
actually wraps the curved 3D surface of the earth, like the surface of a hollow sphere, in 
order to maintain constant altitudes above the earth.  This can be illustrated by viewing 
very large CAPPIs in the 3DF panel. 
 
When the CAPPI height or position is being dynamically changed, the data will 
temporarily “down-sample” to a rectilinear grid.  The resolution of this grid is set to 80 x 
80 pixels by default (this can be changed using the Preferences button).  Once the re-
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positioning of the CAPPI is completed, the data will re-draw at the highest resolution 
available, in polar coordinates. 
 
Reading the Legends 
The upper right portion of this panel contains a height legend, showing the current height 
and the maximum allowable height in kft.   
 
The X- and Y-axes contain tick marks and labels for the horizontal distance in nm. 
 
The lower right portion of the panel shows the latitude/longitude coordinates of the 
upper-left and lower-right corners of the CAPPI, in decimal degrees. 
 
Change Vertical Height 
Move the cursor to the vertical blue bar on the right hand side of this panel.  Then, hold 
down the Left mouse button and drag the top of the blue bar up or down to change the 
height of the CAPPI.  Release the mouse button when completed.  The CAPPI height will 
simultaneously change in the 3DF panel (NOTE:  The CAPPI surface must be toggled on 
in the 3DF panel in order to view those changes in that window).  As you change the 
vertical height, note the changes in the upper right legend. 
 
Zoom 
Hold down the Middle mouse button to initiate a continuous zoom function.  Push the 
mouse away from you to zoom in for a closer view.  Pull the mouse toward you to zoom 
out for a wider view.  Release the mouse button when completed.  Note that any zoom 
action is simultaneously repeated in the PPI and 3DF panels. 
 
Pan 
Hold down the Left mouse button to initiate a continuous pan function.  Drag the mouse 
to “pull” the image to the desired location.  Release the mouse button when completed.  
Note that any pan action is simultaneously repeated in the PPI and 3DF panels. 
 
Interpolation Toggle 
The “I” Hotkey will toggle interpolation on and off on the vertical cross-sections and the 
CAPPIs simultaneously.  The default state of the FSI is for interpolation to be toggled on.  
The interpolation scheme will “fill in” the data between the elevation scans in order to 
present a “more complete” cross-section.  However, turning the interpolation scheme off 
gives the user a better idea of which locations in space the radar is actually scanning, and 
more importantly, where the radar is not scanning.  There are significant gaps in coverage 
since the radar beam is 1.0° wide (in the horizontal and vertical), and elevation angle 
differences can frequently be greater than 1.0°, especially at higher elevations. 
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The interpolation scheme in the vertical between adjacent beam centerlines, and is not an 
image smoothing technique.  This is important for the CAPPI cross-sections since there 
can be significant gaps in coverage.  These gaps are filled in be data just above and below 
these gaps.  If they were filled in from the “sides” (horizontally), significant visualization 
errors would result. 
 

3DF Panel Usage 
 
The Data Area 
The main portion of this panel contains the radar data viewing area.  All data shown in 
this panel is plotted in three-dimensional space, using an earth-centric coordinate system 
where the origin is located at the center of the earth “sphere”.  The radar data are 
represented as two-dimensional surfaces, or “textures” plotted in 3D space with latitude, 
longitude, and altitude coordinates.  For example, the earth’s surface is plotted as a 
sphere, and a low-resolution image can be toggled using the Maps function if a user 
desires to easily illustrate this.  Radar data is plotted at constant elevation angle (as 
“cones”), constant altitude (as a section of a sphere at a higher altitude than the earth 
sphere), and vertical cross section “ribbons”.  The user can zoom, pan, pitch, yaw, and fly 
about and through the data in 3D. 
 
Reading the Legends 
The main portion of this panel contains a color key legend, showing data values and 
corresponding colors used to plot the data at those values.  This color key is shared by all 
four panels. 
 

 
 
The lower right portion of the panel shows the 4-letter radar ID, the date and time in UTC 
(YYYYMMDD-HHMMSS), the radar product (Reflectivity, Velocity, Storm-Relative 
Velocity, or Spectrum Width), and the elevation angle in degrees.  The extra information 
within the brackets can be ignored. 
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Toggling the cross-section surfaces 
You can toggle the two cross-section surfaces off and on independently. 
 

Vertical Cross-Section Surface 
The “X” Hotkey will toggle this surface on or off.  The default state is for this 
surface to be turned on. 
 
CAPPI Surface 
The “C” Hotkey will toggle this surface on or off.  The default state is for this 
surface to be turned off. 

 
Vertical Cross-Section Control Tool 
In the 3DF panel, at the base of the Vertical Cross-Section Surface is another vertical 
cross-section control tool with Blue Boxes on a red and white dashed arrow.  This tool is 
used exactly like the vertical cross-section tool in the PPI Window. 
 
NOTE:  If the viewing angle in the 3DF Panel is set to a 90° plan view, the Vertical 
Cross-Section Surface will appear as just the Vertical Cross-Section Control Tool (since 
you are looking straight down on the vertical surface from the top). 
 
3D Rotate 
In the “3D world”, the rotate function changes your viewing angle while maintaining a 
constant viewing distance and constant viewing location. 
 
Hold down Shift key and Left mouse button to initiate the rotate function.  Slide mouse 
toward you to increase viewing angle, away to decrease viewing angle, left to rotate view 
clockwise, or right to rotate counterclockwise.  Release the mouse button when 
completed.  Note that any rotate action produces no affect in the PPI and CAPPI panels. 
 

The North Arrow 
In the “3D world” it is very important for the user to have a sense of their 
orientation in both the vertical and horizontal.  Therefore, the FSI provides a 
“North Arrow”.  This cursor only remains visible while rotating, zooming, or 
panning, and on the PPI, CAPPI, and 3DF panels.  Note that the North Arrow 
never changes position or orientation on the PPI or CAPPI panels, as these are 2D 
data panels.  On the 3DF panel, the North Arrow will point in the direction of the 
North Pole.  The cursor is also always plotted to be tangent to the earth’s “flat” 
surface, so if the image is tilted from a 90° viewing angle, the cursor will appear 
“squashed”.  With a little practice, you will see how this cursor will aid you in 
your orientation. 

 
3D Zoom 
In the n the “3D world”, the zoom function changes your viewing distance while 
maintaining a constant viewing angle and constant viewing location. 
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Hold down the Middle mouse button to initiate a continuous zoom function.  Push the 
mouse away from you to zoom in for a closer view.  Pull the mouse toward you to zoom 
out for a wider view.  Release the mouse button when completed.  Note that any zoom 
action is simultaneously repeated in the PPI and CAPPI panels. 
 
3D Pan 
In the “3D world”, the pan function changes your viewing location while maintaining a 
constant viewing angle and constant viewing distance.  This is similar to the view a 
“flying airplane” would have if they flew without changing altitude. 
 
Hold down the Left mouse button to initiate a continuous pan function.  Drag the mouse 
to “pull” the image to the desired location.  Release the mouse button when completed.  
Note that any pan action is simultaneously repeated in the PPI and CAPPI panels. 
 
Resetting to a Plan View 
The “P” hotkey, or the Plan View button will reset the 3DF view to a fixed at 90° (top-
down) with north facing up. 
 

Changing Radar Products 
 
RPS List 
NOTE:  In order to view any 8-bit base radar products from all elevation angles, your 
AWIPS RPS list must include the Z, V, and SW products from all of these elevation 
angles for each of your dedicated radars.  Although the SRM product is not required to be 
in the RPS list (it is computed on the fly in the FSI), it is also recommended to be 
included.  You may need to raise your RPS limit to allow more products in order to 
include all of these products and elevation angles. 
 
Reflectivity (Z) 
When the FSI is launched, the 8-bit Reflectivity data at 0.5° is automatically loaded.  But 
if you are ever browsing one of the other radar products, the “Z” hotkey will select the 
Reflectivity product.  Alternatively, the “1” hotkey on the alphanumeric keyboard (not 
the numeric keypad) will also select Reflectivity. 

 
Velocity (V) 
The “V” hotkey will select the ground-relative 8-bit Velocity product.    Alternatively, 
the “2” hotkey on the alphanumeric keyboard (not the numeric keypad) will also select 
Velocity. 

 
Storm-Relative Velocity Map (SRM) 
The “S” hotkey will select the ground-relative 8-bit Storm-Relative Velocity (SRM) 
product.    Alternatively, the “3” hotkey on the alphanumeric keyboard (not the numeric 
keypad) will also select SRM. 
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Spectrum Width (SW) 
The “W” hotkey will select the ground-relative 4-bit Spectrum Width product.    
Alternatively, the “4” hotkey on the alphanumeric keyboard (not the numeric keypad) 
will also select Spectrum Width. 

 
Z/SRM8 toggle (Cycle) 
As with D-2D, the decimal key on the numeric keypad (and not the period key on the 
alphanumeric keyboard) will toggle the display between the Reflectivity (Z) and the 
Storm Relative Velocity Map (SRM) product.  NOTE:  There is no method for fading 
between these two products in the FSI.  Unfortunately, the OpenGL graphics libraries 
that FSI is built upon do not allow this feature. 

 
Browsing the Radar Data 

 
Virtual Volume Scans 
Radars scan in sets of elevation angles known as “volume scans”.  In the current 
paradigm of WSR-88D algorithms, any products created using data from every elevation 
scans are created after the last elevation angle of every volume scan.  This includes the 
rudimentary cross-section product than can be requested from the ORPG.  These volume 
scan products are only available once per volume scan, and update only as fast as the 
volume scan update rate. 
 
Virtual volume scans, on the other hand, are comprised of the latest elevation angle at 
any one time, such that a complete set of elevation angles is available for processing all 
the time.  For example, consider a radar that begins scanning at the 0.5° elevation angle, 
and continues upward through all elevation angles until the 19.5° elevation angle.  Once 
all of the elevation angles have been scanned, the first “traditional” volume scan is 
completed.  Next, the radar will now scan the 0.5° elevation angle again to start the next 
“traditional” volume scan.  In the virtual volume scan world, that new 0.5° elevation 
angle will replace the previously scanned 0.5° elevation angle.  The virtual volume scan 
now updates, and will be comprised of this new 0.5° angle, and the remaining elevation 
angle data from the previous traditional volume scan.  At this point, radar and display 
applications can be recalculated using this virtual volume of data.  Next, the second 
elevation angle will be scanned, and it will replace the previous data at that same 
elevation angle, once again updating the virtual volume scan, and radar and display 
applications run again (in rapidly updating fashion). 
 
In the FSI, the vertical cross-sections and the CAPPIs are all built using the latest virtual 
volume scan when the user is perusing data on the current virtual volume scan.  Users 
will note that both of these cross-sections will re-draw upon the receipt of a new 
elevation scan, about every 15-30 seconds. 
 
However, if the user decides to browse past data, or elevation scans which are not on the 
current virtual volume scan, then that cross-section data will represent the data for the 
traditional volume scan matching the elevation angle being browsed. 
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AutoUpdate 
The AutoUpdate feature is automatically switched from the on position to the off position 
when the user browses out of the current virtual volume.  The AutoUpdate feature will 
automatically switch back to the on position if the user returns to the current virtual 
volume while browsing.  Note that at any time, the user can manually toggle the 
AutoUpdate feature back on while browsing older data, and if so, the display will 
automatically move forward to the latest virtual volume while maintaining a constant 
elevation angle.  Note that any time the currently browsed elevation angle is 
“AutoUpdated”; the display will update to show the new data without changing elevation 
angle. 
 
Numeric Keypad 
The numeric keypad is mapped as the main volume browser.  In order for the keypad to 
operate, the NumLock must be toggled to the ON position.  Note that when referring 
to hotkeys on the numeric keypad, we will refer to the non-numeric and numeric 
designations of that key, to avoid confusion with the numbered keys along the top row of 
the main computer keyboard.  The figure below shows a mapping of the functionality of 
the volume browsing controls. 
 

 
 
 
Changing Elevation Angle 
As with cross-sections using the virtual volume scans, browsing that data is dependent on 
the choice of browsing hotkeys as well as the elevation angle that is currently being 
browsed.  The user can change the elevation angle of the data within the current “live” 
virtual volume scan, or within past traditional volume scans with a different set of hotkey 
functions. 
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Pg Up (9) 
This increases the elevation angle within the current virtual volume scan.  When 
the most recent elevation angle (as shown in the Radar Status Bar) is reached via 
browsing, another PgUp command will move up to the next elevation angle from 
the previous traditional volume scan.  Continuing PgUp commands will 
eventually “wrap” through the entire virtual volume.  This means that a PgUp 
command executed on the highest elevation angle in the virtual volume (e.g., 
19.5°), will bring you to the 0.5° elevation angle within the virtual volume. 
 
Note the times of the products when browsing the virtual volume scan.  They will 
always increase in time while using the PgUp command, except when moving 
between the most recent elevation angle in the virtual volume, to the next higher 
elevation angle. 

 
Pg Dn (3) 
This decreases the elevation angle within the current virtual volume scan.  This 
has the exact opposite effect of the PgUp command, always moving down in 
elevation scan through the current virtual volume. 
 
Note the times of the products when browsing the virtual volume scan.  They will 
always decrease in time while using the PgDn command, except when moving 
between the most recent elevation angle in the virtual volume, to the next lower 
elevation angle. 
 
Up Arrow (8) 
This increases the elevation angle within a traditional volume scan, and is used for 
browsing data from past (not current) volume scans.  The times of the products 
will always increase in time while using the Up Arrow command, including when 
moving from the highest elevation angle in the traditional volume scan (e.g., 
19.5°) to the lowest elevation angle (0.5°), such that the browser will move 
forward to the next traditional volume scan.  Note that once the most recent 
elevation scan as depicted in the Radar Status Bar is reached, the Up Arrow key 
will have no effect (at least, until the next elevation scan comes in). 
 
Down Arrow (2) 
This decreases the elevation angle within a traditional volume scan, and is used 
for browsing data from past (not current) volume scans.  This has the exact 
opposite effect of the Up Arrow command, always moving down in elevation 
scan and backwards in time through past traditional volume scans. 
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Changing Scan Time At Constant Elevation Angle 
 
Right Arrow (6) 
This moves forward in time exactly one volume scan interval while maintaining 
constant elevation angle.  Once the browser is on the most current virtual volume 
scan, this arrow will have no effect. 

 
Left Arrow (4) 
This moves backward in time exactly one volume scan interval while 
maintaining constant elevation angle. 

 
Special Volume Browsing Hotkeys 

 
NOTE:  These special volume browsing keys use the arrow keys that are not part 
of the numeric keypad.  They will be referred to without a corresponding 
numeric key designation.  The figure below shows a mapping of the functionality 
of the volume browsing controls.  You must hold the Ctrl key along with these 
arrow keys for the following functionalities. 
 

 
 
Ctrl-ArrowLeft 
This moves the display to the 0.5° elevation scan in the traditional volume scan 
you are currently viewing.  If you are within the current virtual volume scan, this 
moves the display to the 0.5° elevation scan in that virtual volume. 
 
Ctrl-ArrowDown 
This moves the display to the 0.5° elevation scan forward in time to the current 
virtual volume scan.  If you are already within the current virtual volume scan, 
this moves the display down to the 0.5° elevation scan in that virtual volume.  
This key will toggle the AutoUpdate feature on if it is off. 
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Ctrl-ArrowRight 
This moves the display to the most recently collected elevation scan in the current 
virtual volume scan, the elevation scan that matches that shown in the Radar 
Status Bar.  This key will toggle the AutoUpdate feature on if it is off. 
 
Ctrl-ArrowUp 
This hotkey has no effect. 
 

More Hotkeys and the rest of the Menu Bar 
 

Navigate 
A full list of the traditional volume navigation hotkeys, and some alternative 
volume browsing hotkeys, is obtained by clicking the Navigate selection on the 
Menu Bar.  You can also select any of these functions by left clicking the menu 
selection. 
 
Camera 
A list of some alternative display navigation hotkeys is obtained by clicking the 
Camera selection on the Menu Bar.  You can also select any of these functions 
by left clicking the menu selection. 
 
Options 
A list of additional display option hotkeys is obtained by clicking the Options 
selection on the Menu Bar. You can also select any of these functions by left 
clicking the menu selection. 
 
Products 
A list of the product selection hotkeys is obtained by clicking the Products 
selection on the Menu Bar.  You can also select any of these functions by left 
clicking the menu selection. 
 
Map 
Map overlays can be added, hidden, and removed using the Map selection on the 
Menu Bar.  Individual Map overlay attributes can also be changed here, such as 
map colors and line thickness. 
 
Clicking this menu selection will bring up a drop-down menu listing all the 
currently loaded maps (if any).  For any maps which are already loaded, you can 
left click on the map name, and a sub-menu will appear allowing you to make the 
map invisible or visible (without unloading  the map from the display), or remove 
(unload) the map completely from the display.  For some maps, you may also be 
able to change the map color and the map line thickness. 
 
At the bottom of the menu is the Add Map selection.  Clicking Add Map opens 
the New Map GUI, which allows user to select maps from the list, type in an 
explicit map file location, or browse to a map file to load new maps.  After 
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making the selection, the Name field must contain an (arbitrary) map name, if not 
already specified.  Note that the FSI only displays shapefile (.shp) formatted 
maps. 
 

 
 
 

Setting Preferences 
 
This button will open up the Edit Preferences pop-up window.  The following 
preference tabs are available: 
 
Snapshot 
These preferences determine where and how your screen snapshots are saved. 
 
 Output Location > Directory 

The user may use the Browse button to choose a directory in which to save 
snapshot images, or simply write the directory path in the dialog window. 
 
Output Location > Filename 
This string determines the format of the snapshot image file name.  The Help 
button will provide a list of the Substitution codes that are preceded by the percent 
(%) symbol. 
 
Dimensions > Use Custom Size for Snapshots 
Clicking this toggle button will allow you to set a custom size for your snapshot 
images.  Otherwise, they will be saved in the native resolution of your display.  
You can set the Width and the Height (in pixels) of your snapshot size here. 
 

Display 
These preferences determine the resolution of your display. 
 
 Drawing > Font Size 

The user can select the font size of the labels on the display here.  The default 
setting is 12 pixels. 
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Drawing > Radial Set Accuracy 
We recommend that the users do not change this setting.  The default setting is 2 
radials per degree. 
 
Dynamic Slice > Minimum Sample Drag Resolution 
When the CAPPIs and Vertical Dynamic Cross-Sections coordinates are in the 
process of dynamically changing through the various actions available, the data 
will temporarily “down-sample” to a rectilinear grid.  Once the re-positioning of 
the cross-section is completed, the data will re-draw at the highest resolution 
available, in polar coordinates.   
 
This preference allows the user to change the resolution of the down-sample grid.  
The default setting is 80, for an 80 x 80 pixel resolution.   Making this value 
larger will improve the resolution of the down-sampled dynamic cross-sections, 
but at a cost of reduced performance (“choppier” dynamic slicing).  Making this 
value smaller will reduce the resolution of the down-sampled dynamic cross-
sections, but will improve the performance of the dynamic slicing (more fluid). 

 
Cache 
These preferences control the memory cache.  It is recommended that only advanced 
users use these preferences, as they will affect the amount of memory usage by the FSI 
on the LX workstation, and could affect the entire workstation performance.  For more 
information, consult the section on Memory Management in this guide. 
 
Loop 
These preferences control the animation settings of the FSI. 
 

Preview 
This data graphically displays the animation settings below.  The bar at the top 
shows the number of frames in white, and the first and last frame dwell time in 
blue.  Underneath lists the amount of time that one loop will animate in real-time.  
Under that lists the amount of data, in minutes, that one loop represents.  Note that 
none of these fields are interactive with the mouse, and only change based on 
settings changed in the fields described next. 
 
Data > Frame Interval 
This sets the number of minutes per radar frame in the loop.  It is recommend that 
this value is set to the approximate volume scan update time for the particular 
VCP you are viewing (5 min for VCP 11, 4 min for VCP 12, 6 min for VCP 21, 
and 10 min for VCPs 31 or 32). 
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It is important to note that the FSI animation controls have been designed for 
multiple sources of data (multiple radars and sensor), and are not keyed to 
individual single radar volume scan times.  The frame intervals essentially “take a 
snapshot” of the radar state at those particular times.  For example, if the volume 
scan update rate is 5 minutes, and the Frame Interval is set to 2 minutes, then the 
following results: 
 
 Frame 1:  0 min, volume scan 1 
 Frame 2:  2 min, volume scan 1 
 Frame 3:  4 min, volume scan 1 
 Frame 4:  6 min, volume scan 2 
 Frame 5:  8 min, volume scan 2 
 Frame 6:  10 min, volume scan 3 
 Frame 7:  10 min, volume scan 3 
 Frame 8:  10 min, volume scan 3 
 Frame 9:  10 min, volume scan 4 
 Frame 10:  10 min, volume scan 4 
 Frame 11:  10 min, volume scan 5 
 …and so on… 
 
Data > Number of Frames 
This sets the number of frames you want in the loop. 
 
Speed > Frame Display Time 
This sets the number of milliseconds that a single frame is shown in real-time 
during the loop. 
 
Speed > First Frame Dwell 
This sets the length of the first frame dwell in seconds. 

 
Speed > Last Frame Dwell 
This sets the length of the last frame dwell in seconds. 
 
Options > Rock Loop 
If checked, the loop will rock forward and backward in time.  If not checked, the 
loop will only operate in forward time. 

 
Close 
Clicking this button at the bottom of the GUI will close the Edit Preferences GUI and 
save all your settings. 
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Taking Snapshots 
 
Clicking the Snapshot key in the Button Panel opens the Snapshot GUI.  A default 
filename selection will be first given, based on the parameters set in the Snapshot 
Preferences.  However, you can save the file as any name, to any folder, using the 
browsing tools in the GUI.  FSI saves images in PNG (.png) image format only. 
 

 
 
 

--CCOONNFFIIGGUURRAATTIIOONN--  
 

Choice of Products 
 
px1:$FXA_HOME/data/FSIproducts.txt 
Editing this file on px1 will determine which radar products will be used for the base 
Reflectivity, Velocity, and Spectrum Width data in FSI.  For Z and V, users have a choice 
of 4-bit (level16) and 8-bit (level256) base radar data in FSI.  Although 4-bit data is not 
recommended due to its low resolution, it is available as a choice if needed.  8-bit data 
are preferred for Z and V and are set as the default products.  Spectrum Width is only 
available in 4-bit. 
 
NOTE:  In order to display any of the above products in FSI, they must be included in 
your RPS list.  Of particular note, in order to display full volumes of data in FSI, you 
must have every elevation scan in the VCP in the RPS list. 
 
NOTE:  You can only define one type of each of the three base radar moment products!  
For example, you cannot have both a 4-bit and 8-bit Reflectivity product defined. 
 

FSI User’s Guide: OB8.2 v1.2  Page 30 of 41 



Radar List 
The FSI is designed to allow display of base products only from your WFO’s dedicated 
radar list.  You can also display radar products from your WFO’s backup radar list as 
well.  To add more radars, ask your ITO to edit: 
 
 /data/fxa/tstorm/scanBackupRadarList.txt 
 
and change the third number on each row from a 0 (off) to a 1 (on) to include it for FSI.  
Start a backup radar request via the RMR if needed.  Your ITO should then restart the 
FSIprocessor. 
 
NOTE:  The OB8.2 version of the FSI will not have the capability to display any 
Terminal Doppler Weather Radars (TDWR) your WFO may have access to.  This 
capability will hopefully be added to a future version. 
 

Individual User Configuration 
 
Default Configuration 
For first time users of FSI, the program will first start up using a default configuration 
preference file.  As individual users begin to change their preferences, these new 
preference will be saved into their user configuration file, so that when FSI is restarted on 
the user account, those preferences will be loaded. 
 
NOTE:  The FSI only allows one configuration file per user account. 
 
File > Reset Settings to Default and Exit 
This action will restore the FSI default settings, and overwrite these default settings to 
your personal configuration file.  It will then exit the FSI, since the configuration file can 
only be loaded upon launching the FSI.  Users will need to relaunch the FSI for the 
default settings to take effect. 
 

Color Maps 
 
Default Colormaps 
The default colormaps installed with FSI match the D2D defaults for 8-bit Reflectivity 
and 8-bit Velocity. 
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Changing Colormaps 
Currently, there are no colormaps selection or editing tools within the FSI (this may be 
added in FSI2.0).  In order to change the colormaps, one must replace the default 
colormap file with an alternative colormap file. 
 
NOTE:  This procedure should be carried out with the assistance of your ITO.  You must 
be careful not to remove the original colormap files during this process. 
 
You must change the colormaps from the command line in Linux at the workstation.  
These changes will only take affect for that workstation, and for all users of that 
workstation.  You must first exit FSI, make the changes, and then restart FSI for the 
changes to take affect. 
 
Reflectivity Colormaps 
To change the Reflectivity colormap: 
 
 cd $W2_CONFIG_LOCATION/colormap 
 cp <new_colormap_file> Reflectivity 
 
For example, NSSL supplied their default colormap as an alternative to the AWIPS 
default.  To change to the NSSL colormap: 
 
 cd $W2_CONFIG_LOCATION/colormap 
 cp Reflectivity_nssl Reflectivity 
 
Here is a side-by-side comparison of the two Reflectivity colormaps: 
 

  
 
To restore the default Reflectivity colormap: 
 
 cd $W2_CONFIG_LOCATION/colormap 
 cp Reflectivity_awips Reflectivity 
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Velocity Colormaps 
To change the Velocity colormap: 
 
 cd $W2_CONFIG_LOCATION/englishUnits/colormap 
 cp <new_colormap_file> Velocity 
 
For example, WDTB supplied an alternative Velocity colormap to the AWIPS default.  
To change to the WDTB colormap: 
 
 cd $W2_CONFIG_LOCATION/colormap 
 cp Velocity_wdtb5 Velocity 
 
To restore the default Velocity colormap: 
 
 cd $W2_CONFIG_LOCATION/englishUnits/colormap 
 cp Velocity_awips Velocity 
 
Spectrum Width Colormaps 
To change the Spectrum Width colormap: 
 
 cd $W2_CONFIG_LOCATION/englishUnits/colormap 
 cp <new_colormap_file> SpectrumWidth 
 
To restore the default Spectrum Width colormap: 
 
 cd $W2_CONFIG_LOCATION/englishUnits/colormap 
 cp SpectrumWidth_awips SpectrumWidth 

 
Use of Desktops to manage D-2D and FSI 

 
2D versus 3D desktops 
The LX workstations are equipped with two video graphics cards.  One card supports 3D 
graphics rendering, and the left and middle monitors are connected to that card.  The 
second card supports only 2D graphics, and the right monitor is connected to that card.  If 
the FSI is launched from a D-2D that is running on the right desktop, a pop-up window 
will appear reminding users that the FSI will not run on that monitor.  The FSI can only 
be launched from the left and middle desktops. 
 
Single versus Multiple Desktop Use 
When the FSI is launched from a D-2D running on one of the 3D desktops (left or 
middle), the FSI application window will appear on the same desktop as the D-2D from 
which the FSI was launched.  The data in the FSI can be re-positioned by another right-
mouse click on the D-2D from which it was running.  However, in order to do this 
effectively, the user may have to minimize or hide the FSI window while working with 
the D-2D on that desktop. 
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One solution to this problem is to use both 3D desktops (left and middle) together to 
control the FSI.  To do this, load and launch the FSI from one of the 3D desktops.  Then, 
on the other 3D desktop, load the FSI extension to that D-2D as well.  Then, from either 
D-2D on either 3D desktop, a right-click will re-position the data in the FSI.  In other 
words, one can control the FSI from the D-2D on the opposite 3D desktop, as long as the 
FSI extension is loaded to it as well.  This allows a user to use a D-2D and the FSI on 
independent desktops. 
 
Another solution would be to launch the FSI from a D-2D initiated from a different 
virtual desktop on the same monitor.  This FSI can be controlled by any D-2D from any 
of the virtual desktops on any of the 3D monitors. 
 
NOTE:  Launching more than 3 instances of D-2D and the FSI on a single workstation 
may negatively affect workstation performance.  If workstation performs suffers, you 
may “dial-down” the FSI Memory Management settings. 
 

Extra or Fewer Workstations 
 
Configuring FSI for extra or fewer workstations 
The default FSI is configured to only run on the workstations listed by the environmental 
variable LX_WORKSTATIONS.  Each workstation is configured to be a “client” of the 
FSI Radar index files that are located on the px1 server.  If the number of workstations at 
a WFO changes (workstations are added or removed), the FSI must be reconfigured using 
the following procedure. 
 
NOTE:  This procedure should be carried out by the ITO. 
 
Shut down any open FSI windows on the workstations.  Then, as user fxa@px1, run the 
following commands: 
 
 cd $FXA_HOME/bin 
 ./stopFSIprocessor 
 ./createRssdConf.sh 
 ./startFSIprocessor 
 
To verify the changes, the contents of the px1:$FXA_HOME/.rssd.conf file look 
something like this: 
 

Client: lx1 
Client: lx2 
Client: lx3 
Client: lx4 
Client: lx5 

 
Path: /data/fxa/tstorm 

 
So that each lx workstation listed in LX_WORKSTATIONS is now listed as a client 
workstation. 
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NOTE:  The createRssdConf.sh script assumes that there is a sequential list of lx 
workstations.  In LX_WORKSTATIONS, if any workstations are listed out of order, or 
any workstation numbers are skipped, the .rssd.conf file will not be created correctly.  In 
this case, you must manually edit the px1:$FXA_HOME/.rssd.conf file to have the 
appropriate list of workstation clients.  To add or delete workstations within the client 
list, simply follow the format above.  Then stop and restart the FSIprocessor. 
 
NOTE:  Only lx workstations with the approved Hewlett-Packard PC hardware are 
guaranteed to work with FSI.  Other workstations comprised of different hardware 
configurations may not be compatible with FSI. 
 

Memory Management 
 
The FSI memory “cache” 
The FSI is graphics intensive, and requires the use of the Random Access Memory 
(RAM) in order the “cache” products and textures in memory for faster volume browsing.  
The RAM on the LX workstations is currently limited to 2 GB, with an additional 2 GB 
of swap space.  The FSI uses a considerable portion of that RAM with its default RAM 
cache settings (160 Products, 32 Cross-Sections); about 500-700 MB of the RAM can be 
in use while using the FSI, while zoomed in at storm scale (see note below).  The D-2D 
and other AWIPS display applications also require use of the RAM.  For example, one D-
2D with a 64 frame all-tilts product loaded requires about 450 MB of RAM.  It is advised 
that users be cautious about how many D-2D products and other applications are running 
on any workstation that FSI is being used.  For example, running three D-2Ds with 64 
frame all-tilts and the FSI on one workstation is not advised.  If you see the performance 
of the workstation becoming sluggish, it is likely that the RAM and swap limits have 
been exceeded (and the workstation starts “thrashing” memory with hard drive space). 
 
NOTE:  This procedure should be carried out with the assistance of your ITO. 
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The FSI cache can be controlled by the Preferences > Cache GUI.  If a user wishes to 
devote more memory to other applications besides the FSI, the user can dial down the 
number of Products and Cross-Sections to cache.  However, the result of this is that 
images will take slightly longer to re-load to the FSI display as they are browsed, as they 
are instead read in from a secondary cache on the hard drive.  Smaller cache size means 
slightly degraded performance in browsing.  The trade-off to using a large cache for FSI 
is that fewer applications or all-tilts frames can be loaded in D-2D. 
 
NOTE:  It is not recommended that you use the FSI as a regional scale monitoring tool.  
If you zoom out to a large scale and set up an animation, the RAM usage can rise to up 
and over 1 GB.  However, if this is desirable, you can dial down the RAM setting 
numbers to reduce the RAM usage, trading off FSI browsing speed performance. 
One way to “clear” the memory cache is to select the “Clear Products” button or 
resetting or exiting the FSI.  The result is that the cache is cleared, but new products and 
textures will need to be re-cached in order to enjoy rapid browsing of the data. 
 
NOTE:  Never change the Secondary (Hard Drive) cache settings. 
 

--TTRROOUUBBLLEESSHHOOOOTTIINNGG--  
 
Incomplete volume scans or no radar data 
Check to see if you have all the elevation angles in your VCPs defined in your RPS list.  
For Reflectivity and Velocity, 8-bit (level 256) data are preferred.  For Spectrum Width, 
only 4-bit (level16) data are viewable. 
 
No maps to choose from in Maps menu 
This is a symptom with the users’ personal configuration file default reset problem 
described at the end of the last section.  To fix this, exit FSI, from the command line, type 
fsi_def from the command line, and then restart FSI. 
 
No storm motion 
AWIPS users choose the storm motion vector (SRM) from the AWIPS Radar Display 
Controls.  If the user chooses “Average Storm Motion from STI”, the STI product must 
be included in the RPS list.  Otherwise, if the user chooses to use a “Custom Storm 
Motion”, the storm motion must be set to something other than zero. 
 
/awips/fxa/data/localizationDataSets/OAX/userMotion.txt is of zero size 
When a workstation is re-localized (required for FSI install), it "zeroes" out the 
userMotion.txt file.  In order to get values in there again, you need to make any change 
in your Radar Display Control settings for storm motion.  That message will then go 
away, and FSI will use the motion setting you just entered. 
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--WWHHAATT  FFSSII  MMAAYY  OOFFFFEERR  IINN  TTHHEE  FFUUTTUURREE--  
 

Some of these upgrades are tentative based on resource and budget allocation within the 
AWIPS program. 
 
OB8.3 

 
Readout (Data Sampling) 
Readout is a continuous data sampling capability using a linked cursor on the four panels.  
Data readouts on the CAPPI or Vertical Cross Section panels will show a corresponding 
readout “box” on the 3D flier, in three-dimensions.  The readout will be similar to that in 
D-2D, except that the readout “box” will color fill with the same color as the sampled 
data value corresponding to the product color map.  Also, the attributes shown in the 
radar will be user adaptable. 
 
Super-resolution Data 
Support for the display of super-resolution reflectivity, velocity and spectrum width data 
when they become available in ORPG10.  Users will have the choice of displaying the 
base radar moment data in traditional resolution or super-resolution data. 
 
Polarimetric Data 
Support for new polarimetric radar data moments (ZDR, ρhv, KDP) as well as Hydrometeor 
Classification Algorithm (HCA) output at all elevation angles. 
 

Beyond… (AWIPS2) 
 
Terminal Doppler Weather Radar (TDWR) 
Support for TDWR data, and its unique interlaced volume coverage pattern. 
 
Colormap Editor 
A graphical user interface (GUI) to create and edit colormaps for the various radar 
products. 
 
BCD format map files 
In addition to shapefile map support, support for AWIPS’s own BCD format map files. 
 
3D Volume Rendering and Isosurfaces 
True 3D capabilities!  Radar data is represented on 3D isosurfaces in 3D space, with 
dynamic isosurface selection.  3D Volume Rendering with continuous “alpha” 
(transparency) settings for any data level, for multiple semi-transparent isosurfaces and 
“lit volumes”. 
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Elevation Scan Data Advection 
Time-to-space correction for elevation scan data to remove the artificial “drift” of radar 
data due to the time differences between collection of elevation scan data.  All elevation 
scans in the virtual volumes will be time-to-space corrected to one of the elevation scans 
(either the latest, or the 0.5° elevation angle tilt).  This will allow the user to analyze the 
true storm core tilt, and removes the spatial discontinuities seen between the latest and 
earliest elevation scans in the virtual volume. 
 
Display of single radars from multiple locations concurrently 
Currently, the FSI is set up to view radar data from a single radar source only.  The 
foundation application of FSI, the WDSSII GUI (wg), is capable of displaying multiple 
data sources, including multiple sources of single-radar data.  See example below with 
KTLX, KINX, KVNX, and KFDR. 
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 “B-Scan” 
A unique data readout capability opens a new window that shows the individual sample 
volume values (color coded) on a Cartesian grid.  The values are continuously sampled as 
the cursor moves over the data.  This can be done in the PPI, CAPPI, Vertical Cross 
Section panels.  A prototype example of a PPI and Vertical Cross Section B-scans are 
shown in the next two figures. 
 

      
 
3D grids of Multiple-Radar data 
The National Mosaic Quantitative Precipitation Estimation (NMQ) project is underway, 
and soon, 3D grids of data combined from multiple-radars will be available as a data 
stream from NCEP and made available to AWIPS for flood applications.  The WDSSII 
GUI is capable of displaying these multiple-radar grids, and the FSI will be capable of 
slicing and dicing these grids as well.  See example below. 
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Near-Storm Environment (NSE) thermodynamic data integration 
Adding the capability to include NSE thermodynamic data in the cursor readout, as well 
as including temperature data on the vertical cross-sections (e.g., the height of the melting 
level).  A novel concept may also be introduced – the Constant Temperature PPI 
(CTPPI), which would allow the user to dynamically change the height of a constant 
temperature surface using a slider bar similar to the CAPPI.  These capabilities would be 
highly desirable for analysis of polarimetric variables in relation to updraft 
development/strength and winter storm analysis. 
 

--FFSSII  MMAAIILLIINNGG  LLIISSTT--  

The listserv mailing list ‘awips-fsi’ is available for information, news, discussion, and 
feedback on the FSI.  The MDL developers that are responsible for the FSI are members 
of this list, and are available to answer any questions.  We also envision that, as the list 
grows, your peers can become a valuable resource for information. 

To join, navigate your browser to the Lyris ListManager 

 http://infolist.nws.noaa.gov/read/all_forums/

and hit the Subscribe button on the right side of the awips-fsi row.  You may need to hit 
the “Show More” button to reveal the entire list of mailing lists. 

--FFUURRTTHHEERR  RREEAADDIINNGG--  

• 22nd AMS Severe Local Storms Conference Paper, Presentation 
• 32nd AMS Radar Conference Paper, Presentation 
• 1st NWS Severe Weather Warning Technology Workshop Presentation 
• NWS Operational Services Improvement Plan (OSIP) Statement of Need (SON), 

Project Plan (PP), and Concept of Operations (ConOps). 

--PPOOIINNTTSS  OOFF  CCOONNTTAACCTT--  

Greg Stumpf, Team Lead, CIMMS and NWS/MDL, Norman, OK,  
work: 405-325-6773, cell: 405-826-8644 

Tom Filiaggi, NWS/MDL, Boulder, CO, 303-497-6578 

Dr. Stephan B. Smith, NWS, 301-713-1768 ext 160 

Mike Magsig, NWS/WDTB, Norman, OK, 405-325-2995 
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                    AAPPPPEENNDDIIXX  AA::      FFSSII  QQUUIICCKK  RREEFFEERREENNCCEE  GGUUIIDDEE  
    

Action Procedure 
CAMERA VIEW MANIPULATION 

PAN PPI, CAPPI, VDX, 3DF:  Hold Left Mouse, drag image 
ZOOM PPI, CAPPI, VDX, 3DF:  Hold Middle Mouse; slide 

toward (away) from you to zoom in (out) 
CAPPI HEIGHT CAPPI:  Left Click and drag blue bar on right of panel 
3D ROTATE 3DF:  Hold Shift-Left Mouse, slide toward (away) to 

increase (decrease) viewing angle; slide mouse left (right) 
to rotate view clockwise (counterclockwise) 

INTERPOLATE CAPPI, VDX, 3DF:  Hit “I” 
PLAN VIEW 3DF:  Hit “P” 
TOGGLE VERTICAL 
CROSS-SECTION 

3DF:  Hit “X” 

TOGGLE CAPPI 3DF:  Hit “C” 
VERTICAL CROSS-SECTION (VSLICE) POSITION 

SWING ENDPOINTS Left Click and drag blue box on either end 
MOVE LINE Left Click and drag the middle blue box 
ROTATE Left Click and drag the 2nd or 4th blue box 

PRODUCT SELECTION 
REFLECTIVITY Hit “Z” or Hit “1” 
VELOCITY Hit “V” or Hit “2” 
SRM Hit “S” or Hit “3” 
SPECTRUM WIDTH Hit “W” or Hit “4” 
Z/SRM8 TOGGLE Hit “.” (the decimal key on the numeric keypad) 

VIRTUAL VOLUME BROWSING (*NUMLOCK MUST BE ON) 
UP ELEVATION Numeric Keypad:  Pg Up (9) 
DOWN ELEVATION Numeric Keypad:  Pg Dn (3) 
LATEST 0.5° TILT Arrow Keypad:  Ctrl-ArrowDown 
LATEST TILT Arrow Keypad:  Ctrl-ArrowRight 
FORWARD IN TIME Numeric Keypad:  Right Arrow (6) 
BACK IN TIME Numeric Keypad:  Left Arrow (4) 

TRADITIONAL VOLUME BROWSING (*NUMLOCK MUST BE ON) 
UP ELEVATION Numeric Keypad:  Up Arrow (8) 
DOWN ELEVATION Numeric Keypad:  Down Arrow (2) 
DOWN TO 0.5° TILT Arrow Keypad:  Ctrl-ArrowLeft 

MANAGING THE APPLICATION 
TOGGLE AUTO UPDATE Hit “A” 
RESET DISPLAY The Reset button 
EXIT From Menu Bar:  File > Exit 
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